CHAPTER 1

BSBITU302 - Create Electronic Presentations

GETTING TO KNOW POWERPOINT

( : INFOcus

Microsoft PowerPoint 2016 is part of the suite of programs known
as Microsoft Office. You can use PowerPoint to create and share
dynamic presentations, or slide shows as they are most commonly
called.

Before you start to use PowerPoint, let’'s spend a bit of time learning
about the PowerPoint window and its features.

In this session you will:

learn how to start PowerPoint from the desktop
gain an understanding of the PowerPoint start screen
learn how to create a new blank presentation

gain an understanding of the PowerPoint screen
gain an understanding of how PowerPoint works
learn how to use the ribbon

learn how to use ribbon keytips

learn how to show and hide the ribbon

gain an understanding of Backstage view

learn how to use shortcut menus

gain an understanding of dialog boxes

gain an understanding of the quick access toolbar
gain an understanding of the status bar

learn how to exit safely from PowerPoint.
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STARTING POWERPOINT FROM THE DESKTOP

To create or edit a presentation, you must first you will need to open PowerPoint by using either
start PowerPoint. If your computer uses Windows the All apps option in the Start menu or the
10 it will open from the desktop. Unless you have Search the web and windows bar.

previously created a shortcut icon on the desktop

0 (% Cara Life at a glance

Try This Yourself:

Freelancer.com
chemphill, these Content Writing,

Before you begln’ ensure Excel and Articles projects and
that your Computer |S contests might interest you
switched on and the desktop Mail

is displayed...

If there is no PowerPoint e
icon in the taskbar at the Microsoft Edge
bottom of the desktop, click Cloudy

on the Windows icon, as o s
shown, to display the Start 18° i -l

screen Canberra Phone Compa... OneNote

Click on All apps to display a Play and explore
list of all the apps on your
computer

S
O] -

Groove Music Films & TV

Scroll down to the P section

PowerPoint 2016 is listed Sy »
here... St Investigation into deaths of
wNIKKEI225  five pregnant women

Click on PowerPoint 2016 to

. File Explorer >

start PowerPoint Money News
@ Settings

Right-click on the PowerPoint .

icon in the taskbar to display S boer

a menu of options, as shown, = Allapps

then select Pin this program ;

to taskbar Search the web and Windows

You can now click on this
icon to open PowerPoint
from the desktop. This icon
will remain in the taskbar
unless you remove it...

Repeat step 5 to select
Close window to close
PowerPoint

Click on the PowerPoint icon
in the taskbar to open
PowerPoint again

For Your Reference... Handy to Know...
To add a PowerPoint icon to the desktop ¢ You can start PowerPoint by clicking in the
taskbar: taskbar Search... bar, typing word, then
1. Display the Start menu, then click on All clicking on PowerPoint in the list of search
apps results.
2. Right-click on PowerPoint 2016 e Pin PowerPoint to the Start menu by
B Seled B i (EekeED displaying the All apps list, right-clicking on

PowerPoint 2016 and selecting Pin to Start.
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UNDERSTANDING THE START SCREEN

Most of the time, when you open PowerPoint, the
start screen will display. From this initial screen

you can choose the kind of presentation you want
to work with. You can choose to work with one of

your most recently accessed files, open a
document which has been saved to Computer or
OneDrive or create a new document using the
available templates.

Microsoft PowerPoint 2016 Start Screen

The Microsoft PowerPoint 2016 start screen is very helpful if you want to quickly access files you have
worked on recently or create a new presentation based on one of the available templates (including the
default Blank Presentation template).

If you have already worked on a document or several documents in PowerPoint, these files will display
below Recent in the orange pane on the left of the window. If you haven’t worked on any presentations
yet (as shown below), you can still open existing documents by clicking on the Open Other
Presentations link, located below Recent. This lets you open an existing presentation from your
computer or OneDrive.

The main pane of the start screen displays the available templates you can use to create a new
presentation and a search box at the top that you can use to search the internet for additional templates.
Templates are simply layouts that have already been created with themes applied, that you can
customise to suit your needs and then enter the relevant content. If you want to start with a clean slate,
select the Blank Presentation template — you will probably find this is the one that you use the most,
unless you have corporate or business templates already set up that you must use. There is also a
Welcome to PowerPoint template that you can click on to create a short presentation on using
PowerPoint effectively.

In the top right corner of the screen you will see information about the account that you have used to
sign in to Windows as well as the Help, Minimise, Maximise/Restore Down and Close tools.

B = [m] X
1 Search for online templates and themes pel Ivana Robinson g
owerPoin nammomoonoon IR Y
Suggested searches:  Presentations  Business  Orientation 4:3  Education Switch account -
Blue  Personal
Recent
-
You haven't opened any presentations recently. To I—
browse for a presentation, start by clicking on Open T k 9 Make Interactive Videos
Other Presentations. a e a with PowerPoint and Office Mix
tO U r @ Office Mix
[mw Open Other Presentations
Blank Presentation Welcome to PowerPoint (Create an Office Mix
GALLERY PRRCE
| il o R N

Slice Gallery Parcel

WO0D TYPE

@ ION

Quotable

The start screen will only display when you launch PowerPoint 2016 directly — that is, by clicking on the
application on the Start menu or under search results, or clicking on the taskbar icon if the application
has been pinned to the desktop Taskbar.

PowerPoint 2016 can also be started in Windows 10 by double-clicking on a PowerPoint file in the File
Explorer. When this occurs, PowerPoint 2016 will start with the document open on the screen and the
start screen will be by-passed.
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CREATING A NEW BLANK PRESENTATION

When you want to begin a new presentation, you
can choose to base the new document on an
existing template that has formatting already
applied or start with the default Blank

Presentation template and apply your own
formatting and content. All presentations are based
on a template which defines the basic layout.

Try This Yourself:

Suggested searches:

Before starting this
exercise ensure the

Education  Blue

Search for online templates and themes

Presentations

Personal

PowerPoint start screen
is displayed...

On the start screen,
click on Blank
Presentation as

Blank Presentation

indicated (the first option
beneath the Search for
online templates and
themes box)

A new blank
presentation will open,

7 = O x
o lvana Robinson hr"“
ivanarobinson@outlook.com | L
Business  Orientation  4:3 Switch account | a
T k 9 Make Interactive Videos
a e a with PowerPoint and Office Mix
tour @O
‘elcome to PowerPoint (Create an Office Mix
GALLERY PARCEL
|2 R e
Gallery Parcel

as shown below. Notice
the document is
automatically assigned a
temporary name, which
is displayed in the Title
bar

=

Paste New

Clipboard &

Insert

I:| Layout *
) Reset

e Slide~ [ Section ™

Slides

1

Design

Presentation1 - PowerPoint

Transitions Animations Slide Show Review View

B I U § a2V Shapes Arrange

Font Paragraph Drawin,

For Your Reference...
To create a blank presentation:

1. Open PowerPoint and ensure the start
screen is displayed

2. Click on Blank Presentation in the list of
templates

Handy to Know...

If you already have a presentation open and
want to create a new one, click on the File
tab to open the Backstage, click on the New
tab and select Blank Presentation.

You can use the keyboard shortcut [ctn] + N ]
to create a new presentation based on the
Blank Presentation template.
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THE POWERPOINT SCREEN

The PowerPoint 2016 screen is made up of a view are common to all Office 2016 applications,
number of different components which are so once you know how they are used, you can
described on this page. Some of these transfer this knowledge across to Microsoft Word,
components, such as the ribbon and Backstage Excel, and so on.

Presentation - PowerPoint

Insert Design Transitions Animations Slide Show Review View ACROBAT Q Tell mewhat you want to do

j [ Layout - Lo 2 Find
%] Reset <> u
Paste New = . Shapes Arrange Quic
Slide - T Section - v Styles

30 Replace -
[ Select ~
Clipboard = Slides Font Paragraph Drawing Editing ~

1

Click to add title

Click to add subtitle

Slide 1o0f 1 English {Australia) [ = Notes -Cumments][ E 55 ®H =T - i + &% [ e

The File tab is used to access the Backstage view which contains file management functions, such
as saving, opening, closing, printing, sharing, and so on. There is also information contained here
such as your document Properties. Options are also available so that you can set your working
preferences.

The ribbon is the tabbed band that appears across the top of the window. It is the control centre of
PowerPoint. You use the tabs on the ribbon to access the commands that are categorised into
groups.

The Slides pane provides a preview thumbnail of each slide in your presentation. You can also use
the pane to re-order your slide sequence.

The Status bar appears across the bottom of the window. It displays the current slide number and
will display a spelling icon once you have entered text. If the document contains any spelling errors it
will be indicated on the icon.

The View buttons and the Zoom slider are used to change the view and to increase or decrease the
zoom ratio (magnification) of your slides.

The Notes and Comments tools enable you to enter notes and comments for the presenter that
won'’t be seen by the audience.

The Slide window shows the content of the slide and this is also where you edit the presentation to
add effects, objects, text and so on.

QOO 00 0 O o
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How MICROSOFT POWERPOINT 2016 WORKS

The PowerPoint 2016 screen comprises three larger entity known as a presentation which is also
key areas. The data you type is placed on a a file. Everything you do to the file is controlled in
slide. The data can be manipulated using Backstage view.

commands on the ribbon. The slide is part of a

The Slide
|f you create a hew blank o} s Presentation2 - PowerPoint Ivana Robinson
presentatlon, It WI” appear as a en Design Transitions Animations Slide Show Review View Mm CROBAT QTeHmewhalyr,\uwnodo
) . . o X =~ Layout ~ A = == * i ’~) find.
blank Title slide in the document | - "ol . ' g O W L e -
¢ © Ut == s i W e ) e
window. When you click in one of - S = e B

Clipboard Slides Font Paragraph Drawing Editing

the text placeholders and type, the ——— = o

text will appear centred in the e ' i,

placeholder. You can also create a y
I._ 3

D>

new presentation from a template,
such as the health and fithess
template shown to the right, where
specific placeholders appear by
default in a number of slides so that Lt i
you can use them as a guide for —
editing and adding your own data
or images as required.

3
*

*

s TITLE WITH PICTURES LAYOUT

SUBTITLE

Slide 1 of 12__English (Australia) = Notes B Comments B 5 B 7 -—14 + 5% [

The Ribbon

When you need to do something with the information on a slide, such as format it, move it, copy it, and
much more, you will find all of the relevant commands on the ribbon. The ribbon has the commands
organised thematically using a series of tabs across the top.

Presentation? - PowerPoint Ivana Robinson [Eal m}
Insert Design Transitions Anirmnations Slide Show Review Mix ACROBAT Q Tell me what you want to do P+ Share
.n.D j [ Layout ~ e |, = = 11 r<|;:. DD ? Shape Fill A Find
] Reset - Shape Outline Eo Replace -
Paste New B I U S abc AV- Aa A Shapes Arrange Cuick
- Slide- o Section - - | G - = Shape Effects [+ Select -
Clipboard = Slides Font Paragraph Drawing Editing ~

Backstage View

When you want to do something
with the data in your document,
such as save it so that you can
access it again later, print it, share
it with a colleague, send it to your
boss, protect it from prying eyes,
etc, you will need to access the Sove s Printer

Microsoft Office Backstage view. BEEis 2B tonerione documest v
Backstage view is accessed using

Presentation2 - PowerPoint Ivana Robinson ? = o X

Print I

=) Copies: |1 :’ B
=

Print

Printer Properties

the File tab on the ribbon. Rather L

than offering commands on a (L —

ribbon, Backstage occupies the B e

entire screen and has a series of T i e

options in an orange panel on the = ooy onenesicath. ~

left side. In our sample to the right, s O L - |
Print is active, and that is why you B B - .

can see a preview of the document
and a series of print-related
options.
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USING THE RIBBON

The ribbon is the command centre for
PowerPoint. It provides a series of commands
organised into groups that are placed on
relevant tabs. Tabs are activated by clicking on

BSBITU302 - Create Electronic Presentations

their name to display the command groups.

Commands are activated by clicking on a button,
tool or gallery option. Everything you could possibly
want to do in PowerPoint will be on this ribbon.

Try This Yourself: "
0
Before you begin, ensure e s

that PowerPoint has R

Insert

Design

] Reset

\:I [ElLayout ~
N

ew -
Slide~ [ Section~

Slides

B I

Transitions Animations Slide Show

U § abe &Y

Review View

Font Paragraph

= > [

started and a blank
presentation is open...

o Examine the groups on
the Home tab, e.g.
Clipboard, Slides,

Font etc New  Table
Slide - -
These are the commands T | T

most commonly used...

Design

‘:, D ’j‘D D@Online Pictures

= @4 Screenshot ~

Pictures

Transitions Animations Slide Show

5057 e
Recently Used Shapes

S Photo Album ~ E N NCOOOA L L s

1
e Click on the Insert tab

The commands on this tab

are used to insert items,
such as tables and
pictures...

e Click on Shapes in the
Illustrations group to
display the Shapes gallery

This includes a huge
range of shapes...

o Click on each of the tabs
and examine the
commands

Some of these commands
will open a dialog box...

e Click on the View tab,
then click on Zoom in the
Zoom group to open the
Zoom dialog box

Images

CARTANR N 4

Lines
NANTLL TR NG %
Rectangles
I s L

Basic Shapes
EOANOASOOOO®®
etodOrkyooga
O0®~HOV 16 C 3
QG030

Block Arrows
DEHTOTCHEBPR IS
€ 2VvnoD DD RN
Do a

Equation Shapes
=R =SH#

Flowchart
O0<gootig=cay
CUAr®B X ¢ AVAD
Qsio

Stars and Banners

DO RN0BEERES

Review
t
dction | Comment

Comments

L
]
B

ﬁﬂﬂﬁﬁ'ﬂj@m Zoom

Gallouts
QO 3.0400 40 A Zeemte

Click on [Cancel], then e
click on the Home tab

G A0 AD GO ® Fit
Action Buttons O 400%
nummmnmﬂmgﬁz
----------------------------------------------- O 86%
O s0%
O 3%

Percent: |73% 3

For Your Reference...
To use the ribbon:
1. Click on a tab to display the commands

2. Click on a button to activate a command,
display a gallery or open a dialog box

Handy t

o Know...

* Additional tabs known as Contextual tabs
appear in specific circumstances. For
example, if you insert a picture or have
selected a picture, the Picture Tools:
Format tab will appear. This provides quick
access to all of the tools you may need to
modify and work with the picture.
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USING RIBBON KEYTIPS

Ribbon commands are normally accessed with a
mouse, however, you can also use the keyboard
to do so. When you press E, letters known as
KeyTips or access keys will appear next to

BSBITU302 - Create Electronic Presentations

commands on the ribbon. Pressing the access key
letter on the keyboard will then activate the
corresponding command on the ribbon just as if
you had clicked on the command with the mouse.

Try This Yourself:

Before starting this 0
© © exercise, ensure you have Paste
5T ablank presentation i
Clipboard Slides
open...
1
Press AItItO display the

KeyTips in the ribbon

ew
Slide~ 0 Section~

Presentation3 - PowerPaint

Animations Slide Show Review

B I U § anchY

b

Font Paragraph

Press [6 ] to activate the
Design tab and display the

KeyTips for the Design
commands

Press [s ] to display the
Slide Size options

=

File

=

irc)

Home

Aa

Ay

Ay - Presentation3 - PowerPaint

Insert Transitions Animations Slide Show Review

Press twice to return to
the previous level of

access keys

Variants

Themes

Press several times to
cycle through the
commands on the Design
tab

=

To activate a selected
command, you would

File

i FI
simply press |enter]... ) Er ";’@
From From Pr
Press |esc| to return to text Beggfne Cu
entry mode

=

Home

T A

Insert

1

s Presentation3 - PowerPaint

Slide Show

F@ @

Rehearse Record Slide

Design Transitions  Animations

EEe

Set Up

Play Marrations

szeTimings

Hide

ﬁslide OH- sw- snda—.m Sﬁe Tirﬂgs s»—m- hSthediaContm'S
1t Slide S set

esent Custom Slide

For Your Reference...
To use KeyTips to access commands:
1. Press [ait]to display the KeyTips

2.
the command that you want to select

3. Press [esc] to return to text entry mode

Press the letter key of the command or tab to

Handy to Know...

You can still use the shortcut keys for menu
commands that were available in previous
versions of Office. For example cu1] + (B ]
applies bold to selected text.
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SHOWING AND COLLAPSING THE RIBBON

The ribbon, valuable as it is, does occupy a as a once-off operation or, have it constantly
reasonable amount of screen space. To minimised and display full commands only briefly
maximise your working space, you can minimise when a tab is clicked. You can do all this by using
the ribbon so only the tabs are visible, minimise it the Ribbon Display Options button.

G PowerPaoint Ivana Robinson

Try This Yourself:

------- Auto-hide Ribbon
Hide the Ribbon. Click at the top

w Review View I AC|

Before starting ensure you have a % D[ of the application to show it
blank presentation open... — Show Tabs
4 g Shapes Aran Show Ribbon tabs only. Click a
q g g tab to show th is.
o Click on the Ribbon Display Paragraph Dran e show e commene
g g g — Show Tabs and Commands
Options button in the top right BB bbon tabe o
corner Of the WindOW to dISplay a commands all the time.

menu of options

Notice Show Tabs and Commands
is selected. Let’s hide the ribbon... e

Select Auto-hide Ribbon

The ribbon, Quick Access bar and
title bar will disappear completely...

Point to the top of the screen to
display an orange bar, then click
on the bar

The ribbon will open temporarily...

Click anywhere in the document to e - »ENE3

hide the ribbon
Let’s display the tabs...

Repeat step 3, then steps 1 and 2
to select Show Tabs

Click on the Insert tab to open it
temporarily, then click elsewhere to

hide it again

This view is a good compromise,

providing more screen Space and PowerPoint Ivana Robinson [Ea = O
requiring only one click to display v Review  View Mx  ACROBAT  Q Tellme 9 Share

the tab rather than two clicks as
you do with Auto-hide Ribbon
mode...

Repeat steps 1 and 2 and select
Show Tabs and Commands to
reset the option

For Your Reference... Handy to Know...
To hide/display the ribbon: o |f you wish to quickly collapse the ribbon and
1. Click on the Ribbon Display Options button display only the tab names, double-click on a

tab name, or click on Collapse the Ribbon
located at the right end of the ribbon, or
press + F1 |. You can quickly expand it
again by double-clicking on a tab.

2. Select the desired mode
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UNDERSTANDING BACKSTAGE VIEW

The ribbon lets you work on the content in a File tab, lets you do something with the content
presentation — you can add more content, format you create. You can save it for later use, print it on
it, insert pictures into it, copy it, and much more. paper, send it via email, and more by using the
Backstage view, which is accessed using the options found in Backstage view.

Backstage View
The File tab on the ribbon is not a

Presentation] - PowerPoint Ivana Robinson ? - a X

normal tab — as you can tell by the
fact that it is coloured. Clicking on the
File tab launches a mini-program
within PowerPoint known as
Backstage View. Backstage, as it's
known for short, occupies the entire
window. Presentation ~ Slides 1
Hidden slides 0

At the left of the Backstage is a St Tite Add atitle
navigation pane, which displays a list e e Adebe (@ | IMspectPresentation = Add atag
of options. These options provide you [ Cradcr | comme o g HeEE ey
with access to various operations -
such as printing, saving and sharing.
They can also provide you with
information about your presentation
such as the file size.

Clicking on one of the listed options
displays a range of associated
settings.

The whole underlying purpose of the

Info

Protect Presentation Properties -

Control what types of changes people can make to

Size Not saved yet
Protect this presentation. )

Document properties and author's name

Content that people with disabilitics are
unable to read Last Modified

Related Dates

Created Today, 1:32PM
Last Printed

*ul Manage Presentation
MES\E Check out document o recover unsaved changes. Related People
9 ] There are no unsaved changes.
Presentation ~ J Author
Ivana Robinson

Add an author

Account Last Modified By not saved yet

Show Al Properties

Options

Backstage is to enable you to protect
your data, share it with others, and
provide you with valuable information
both about your data and the status of

Backstage Options
The Backstage provide more options for working with a document

Info Provides status information about the current presentation and lets you
manage versions and permissions.
New Lets you create a new document and provides access to a gallery of
inbuilt templates as well as ready access to a range of online templates.
Open Provides a list of recent documents as well as the option to search
through your Computer, OneDrive or other place, to find what you are
looking for
Save Saves your current presentation (if already saved to a location) or Save As
prompts you to save to a location.
i i i Save as Adobe
Save As Allows you to name your presentation and save it to a location. PDF
Save as Adobe Allows you to save a Word document as a PDF document.
PDF
History Shows version history of the currently open file.
Print Lets you print the current presentation and preview it.
Share Lets you share your presentation with other people via email, online
presentation, blog or Cloud (OneDrive).
Export Allows you to create a PDF/XPS document or change the file type of
your presentation.
Close Closes your current document. s
Account Contains product and user information. Options
Options Presents you with a range of options which assist in the creation and Feedback
editing of your document.
Feedback Allows you to send feedback to Microsoft about PowerPoint.
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USING SHORTCUT MENUS

In addition to the ribbon, PowerPoint also an (often faster) alternative method for locating
features shortcut menus — context-sensitive operations and commands specific to the object or
menus that appear when you right-click on areas area you have right-clicked on. In some instances a
of the screen or slide. Shortcut menus provide mini toolbar may also appear.

Presentation] - PowerPaint

Try This Yourself: iq it Animations SlideShow  Review  View
k Customize Quick Access Toolbar...
Before Startlng thIS exerC|Se . |t3 le “ Show QI._IiEk Access Toolbar Below the Ribbon
ensure that you ha.Ve a - T | Custcmlz&tha.ﬁwhhcn...
blank presentation open Cppears ;s Celpee i e

1

o Point to any of the tabs on
the ribbon, then right-click
to display the shortcut menu

This menu will display

options relating to the e 1
toolbar and ribbon...
e Click elsewhere on the slide Calbrili- |60 -] & A
with the left mouse button BIUS==A-« ?’
to close the shortcut menu L

Paint to one of the text - .
placeholders on the slide, -
then right-click to display L
the shortcut menu and a )

et A Font, e T
mini toolbar 5 Darogroph.. Click to add subtitle
Because you clicked on a = Bulets '

é: Numbering 3
text placeholder, the menu
a FD Convert to Smartért  »
contains Fontand | | = & _
a & Hyperink...
Paragraph options. Cut, D SmortLookur
Copy and Paste are greyed — ,
out when no actual text is Bp Tronslate
SeIeCted. o 4  Format Text Effects...
% Format Shape...

Press [esc] to close the

menu e
1

Right-click on an area of the
slide outside of the text
placeholders

L\\,‘D Paste Options:

This shortcut menu offers TS
slide-specific options... & Layout ,
Reset Slide
e PreSS to C|OSE the ##  Grid and Guides...

shortcut menu Ruler

&) Fcr.matﬂackgrcundm Clle tO add tl

Click to add subtitle

For Your Reference... Handy to Know...
To display a shortcut menu: e Once a shortcut menu appears, you can
1. Point to the object or area of the screen on select an option in it by clicking on that option
which you want to perform an operation with the left mouse button.

2. Right-click to display the shortcut menu
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UNDERSTANDING DIALOG BOXES

Dialog boxes contain a series of controls that right corner of a group on the ribbon, or when you
are used to adjust settings for a particular aspect click on a command that displays a dialog box.

of a document. They appear either when you Dialog boxes are often used for adjusting some of
click on a dialog box launcher in the bottom the more advanced aspects of a document.

Typical Dialog Box Controls

Dialog boxes have various tools to help you perform tasks. These tools are known as controls and
some typical ones are shown below.

Font ? x
Fant  Character Spacing Tabs are used to
provide grouped
Text boxes are Latin text font: Font style: Size: settings in the one
used to enter text +Heading ~ Regular v |60 5 dialog box.
such as font or size. Al text
Font color & * | Underline style |(none} w Underline colar hd DI’Op arrows
provide a list of
Effects .
options for the text
Check boxes turn L] strikethrough L] small Caps box when the arrow
Settings either on or [] Double Strikethrough [ Al Caps is clicked. The list
off. When on they [ superscript Offset: |09 =] [] Egualize Character Height “drops down” from
display a tick and [J subscript the arrow.

therefore these
controls are also

known as tick boxes. cancsl T—— Command buttons

> N _ provide a means of
saving the changed
settings [OK], or
closing the dialog
box without
accepting any
changes made
[Cancel].

Spinner arrows allow you to
type a specific value or use
the up or down arrows to
increase or decrease the
value respectively.
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